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01. INSTALACIÓN Y DESINSTALACIÓN DE SOFTWARE 01. INSTALACIÓN Y DESINSTALACIÓN DE SOFTWARE

PASOS BÁSICOS DE INSTALACIÓN CONFIGURACIÓN DE SOFTWARE

CONFIGURACIÓN DE SOFTWARE

01 • Instalar el software de control de acceso.

02 • Haga clic en "Next".

03 • Haga clic en "Next".

04 • Haga clic en "Next".

01 • Primero coloque el CD en el CD-ROM, luego ejecute la aplicación "setup.exe" o mediante nuestro 
websibe descargando la carpeta de software y ejecute la aplicación "setup.exe", que se encuentra 
dentro del software.

Memoria: 1 GB.
Disco duro: 1 GB por encima del espacio libre.

• Windows 7
• Windows 10

REQUISITOS BÁSICOS DE INSTALACIÓN

OPERACIÓN DEL SISTEMA APOYADO POR SOFTWARE
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CONFIGURACIÓN DE SOFTWARE

RETIRE EL SOFTWARE

RETIRE EL SOFTWARE
01 • Haga clic en "Inicio" y escriba "Panel de control".
02 • Haga clic en " Desinstalar un programa".

03 • Busque el software "Control de acceso" y haga clic en "Desinstalar".

04 • Haga clic en "Si".

05 • Haga clic en "Close".
Una vez completada la instalación, se creará         automáticamente y se mostrará en la pantalla de su 
computadora.

01. INSTALACIÓN Y DESINSTALACIÓN DE SOFTWARE 01. INSTALACIÓN Y DESINSTALACIÓN DE SOFTWARE
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INICIAR SESIÓN INICIAR SESIÓN
Haga clic           o  ejecute Inicio> Programas> Access Control> Access Control, se abrirá la ventana de 

inicio de sesión de la siguiente manera:

Usuario: abc
Contraseña: 123
Se recomienda cambiar su nombre de usuario y contraseña después del primer uso

Si la conexión de SQL Server falla. Aparecerá el cuadro de diálogo anterior.
01 • Haga clic en "Ok ". Consulte el Apéndice Configuración de SQL Server.
Después de iniciar sesión, mostrará la ventana principal de la siguiente manera:

AJUSTES DE PARÁMETROS DEL EQUIPO
AGREGAR/CONFIGURAR CONTROLADOR

02. OPERACIÓN BÁSICA DEL SOFTWARE 02. OPERACIÓN BÁSICA DEL SOFTWARE
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01 • Haga clic en Configuration> Controllers en la barra de menú.
02 • Haga clic en el botón "New" para agregar los controladores al sistema.

El número del controlador (este es el número de serie del controlador) se puede encontrar en la etiqueta 
S / N: ********* del controlador. Por favor complete los nueve números.

“Door Name” y “Reader Position”  se pueden modificar.
04 • Marque " Active ", la consola mostrará la puerta, de lo contrario no se mostrará.
05 • Marque "Attendance" para que los registros en el lector de tarjetas se puedan usar como registros 
de asistencia, de lo contrario no se utilizarán.
06 • Haga clic en "Ok".

03 • Haga clic en "Next".

Si el controlador S / N que escribió no es el mismo que la etiqueta S / N: ********* el software 
no puede comunicarse con el controlador.

Red pequeña: admite comunicación TCP / IP, todos los controladores están en el mismo 
segmento de red.

Red o Internet mediana o grande: admite comunicación TCP / IP a diferentes controladores 
de segmento de red .

02. OPERACIÓN BÁSICA DEL SOFTWARE 02. OPERACIÓN BÁSICA DEL SOFTWARE

AJUSTES DE PARÁMETROS DEL EQUIPO AJUSTES DE PARÁMETROS DEL EQUIPO



7A 7B
ESES

AGREGAR/CONFIGURAR IP

01 • Haga clic en "Search".

03 • Haga clic en "Ok".

Resultado, puede ver la dirección IP.
04 • Haga clic en " Next ".

Los controladores están separados en diferentes redes. Cada controlador debe tener asignada una 
dirección IP única.

La búsqueda tomará unos 5 segundos.
02 • Haga clic en "Configure".

Después de configurar la dirección IP, puede configurar los parámetros del controlador, la dirección IP 
debe asignarse al controlador correspondiente.

02. OPERACIÓN BÁSICA DEL SOFTWARE 02. OPERACIÓN BÁSICA DEL SOFTWARE

AJUSTES DE PARÁMETROS DEL EQUIPO AJUSTES DE PARÁMETROS DEL EQUIPO
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FILTRO IP GESTIONAR LA ZONA DEL CONTROLADOR

Por seguridad, y solo un ordenador tiene acceso a este software y esta base de datos, haga clic en el 
boton derecho y seleccione "Filtro IP".

02 • Haga clic en "Add Top" y escriba en el área en blanco.

03 • Haga clic en "Ok".
Resultado, puede ver la Zona creada .

Ingrese la IP permitida y haga clic en" "Add Allowed IP" "" o haga clic en " Add Curent PC IP".
01 • Haga clic en " Only Update IP List "

01 • Haga clic izquierdo en el controlador y luego haga clic en "Zones".

02. OPERACIÓN BÁSICA DEL SOFTWARE 02. OPERACIÓN BÁSICA DEL SOFTWARE

AJUSTES DE PARÁMETROS DEL EQUIPO AJUSTES DE PARÁMETROS DEL EQUIPO
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02. OPERACIÓN BÁSICA DEL SOFTWARE

AJUSTES DE PARÁMETROS DEL EQUIPO

04 • Haga clic en "Add Branch" para agregar una nueva ubicación debajo de la zona.
05 • Escriba en el área en blanco y haga clic en" Ok ".
Resultado, puede ver la ubicación que creó. 

Cierra esta ventana.
05 • Configure la ventana de Zona en el Controlador.

02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO

01 • Haga clic en Configuración > Departamento en la barra de menú.
02 • Haga clic en el botón " Add Top " para agregar un departamento.
03 • Escriba el área en blanco y haga clic en "Ok".

AGREGAR DEPARTAMENTO
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04 • Haga clic en" Add Branch" para agregar una nueva subdivisión en el departamento.
05 • Escriba en el área en blanco y haga clic en " Ok".
Resultado, puede ver la ubicación que creó.

AGREGAR Y EDITAR USUARIO

01 • Haga clic en Configuración> Personal en la barra de menú.
02 • Haga clic en el botón " Add " para agregar usuarios

03 • Escriba las áreas" "User ID" "y" "Name" .
04 • Para agregar una foto al usuario, haga clic en "Photo" y elija el archivo deseado.
05 • Después de ingresar la información en estos campos de usuario, haga clic en " Add Next " para que 
la ventana de presentación siga abierta y pueda ingresar información de otro usuario.
Si no desea agregar más usuarios, haga clic en " Ok " y el usuario se ha agregado al sistema.

02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO

02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO
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02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO

02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO
06 • Para editar el usuario creado, haga clic en "Editar" .
Puede agregar más información a través del submenú "Others".

Resultado, puede ver las tarjetas de registro.   
04 • Haga clic en " Ok " al final de la operación, y las tarjetas de registro se agregarán al sistema.

AGREGAR AUTOMÁTICAMENTE TARJETA DE REGISTRO

01 • Haga clic en Configuration > Personnel > Auto Add en la barra de menú.
02 • Si selecciona "USBReader", conecte el lector de tarjetas USB (el modelo # para el producto wiegand 
es WG1028) con el ordenador.  
03 •  Haga clic en  "USB Reader" o "Controller" , y luego haga clic en " Next".
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02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO

02. OPERACIÓN BÁSICA DEL SOFTWARE

DEPARTAMENTO DE OPERACIÓN Y USUARIO REGISTRADO
05 • Si selecciona "Manual Batch Input" , las tarjetas de registro se agregarán manualmente.
06 • Haga clic en "Manual Batch Input", y luego haga clic en " Next ".
07 • Escriba en el " Start No. " y " End No. ".
08 • Haga clic en " Ok" al final de la operación y se agregarán tarjetas de registro al sistema.
Resultado, verá las tarjetas de registro. Todas las tarjetas se registran automáticamente, el nombre 
predeterminado es " N+ Número de tarjeta ".

PÉRDIDA DE TARJETA • ACCESO A PRIVILEGIOS

Si alguien pierde su tarjeta, debe registrar la tarjeta perdida y luego redistribuir una nueva tarjeta al 
usuario.
01 • Haga clic en Configuration > Personnel > Card Lost en la barra de menú .

01 • Haga clic en Configuration > Access Privilege en la barra de menú.
02 • Haga clic en "Change Privileges".

02 •  Escriba en el área "New Card NO" el nuevo número de tarjeta y luego haga clic en "Ok" .
Si la tarjeta de usuario tiene algún privilegio, después de informar la pérdida de la tarjeta, actualice el 
controlador.

OPERACIÓN
GESTIÓN DE PRIVILEGIO



13A 13B
ESES

02. OPERACIÓN BÁSICA DEL SOFTWARE

OPERACIÓN

02. OPERACIÓN BÁSICA DEL SOFTWARE

OPERACIÓN

03 • ">> "Seleccione todos los usuarios o todas las puertas opcionales.
"> " Seleccione un usuario o una puerta opcional.
" <" Cancelar un usuario seleccionado o una puerta seleccionada.
" << " Cancelar todos los usuarios seleccionados o todas las puertas seleccionadas.

04 • Al hacer clic en "Allow" y luego en Operation > Upload, los usuarios seleccionados pueden pasar por 
las puertas seleccionadas.
Al hacer clic en "Allow and Upload", los usuarios seleccionados pueden pasar por las puertas 
seleccionadas.
Si hace clic en "Prohibit", y luego en Operation > Upload, los usuarios seleccionados no pueden pasar 
por las puertas seleccionadas.
Si hace clic en "Prohibit and Upload", los usuarios seleccionados no pueden pasar por las puertas 
seleccionadas.

05 • Después de agregar todos los privilegios al sistema, haga clic en Operation > Upload para actualizar 
el controlador.

03 • Haga clic en "Confirm and Upload" si ha agregado puertos opcionales o canceló puertos seleccionados 
para actualizar el controlador y el usuario puede pasar por las puertas seleccionadas.

• EDITAR UN PRIVILEGIO DE USUARIO
01 • Seleccione un usuario y haga clic en"Edit One User".
02 •  " >> " Seleccione todos los puertos opcionales.

"> " Seleccione un puerto opcional.
"<" Cancelar un puerto seleccionado.
"<<" Cancelar todos las puertas seleccionadas.
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01 • Haga clic en Operation > Console en la barra de menú.

INFORMACIÓN DEL CONTROLADOR
01 • Haga clic en Operation > Console > Check en la barra de menú.
El resultado muestra la información básica del controlador, como el número de pases y privilegios de la 
tarjeta, el estado de la puerta, el estado del controlador y más. Si el controlador se comunica bien con 
el ordenador, el color de la puerta será verde, de lo contrario será rojo.

CONFIGURAR UPLOAD

01 • Haga clic en Operation > Console > Upload en la barra de menú.
02 • Haga clic en "Ok". 

02. OPERACIÓN BÁSICA DEL SOFTWARE

CONSOLA

02. OPERACIÓN BÁSICA DEL SOFTWARE

CONSOLA
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02. OPERACIÓN BÁSICA DEL SOFTWARE

CONSOLA

02. OPERACIÓN BÁSICA DEL SOFTWARE

CONSOLA

MONITOR RECIBIR REGISTROS

CONSULTA DE REGISTROS

01 • Haga clic en Operation > Console > Download And Monitor en la barra de menú. 01 • Haga clic en Operation > Console > Download en la barra de menú. Recopila los registros del 
controlador para la base de datos.

"Descargue" "los registros primero" antes de la consulta.
01 • Haga clic en Operation > Query Swipe Records en la barra de menú.

01 • Haga clic con el botón derecho y seleccione "Display More Swipes". Solo muestra registros de 
boletos de tarjeta.

MOSTRAR MÁS REGISTROS
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02. OPERACIÓN BÁSICA DEL SOFTWARE

CONSOLA

02. OPERACIÓN BÁSICA DEL SOFTWARE

CARACTERÍSTICAS
Si desea filtrar entradas y salidas por "Addr" , haga clic en "Query Option".
02 • Haga clic en "Query" para mostrar los registros deseados.

Puede cambiar el nombre y la contraseña del operador.
01 • Haga clic en Tools > Edit Operator operador en la barra de menú.

01 • Haga clic en File > DB Backup en la barra de menú.
02 • Haga clic en " Ok ".
Esta copia de seguridad se escribe en el sistema mediante la ruta " C: \ AccessControl ".
Si la copia de seguridad es SQL DB. La copia de seguridad se escribe en el sistema mediante la ruta "C:\
Program Files\Microsoft SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Backup".

CARACTERÍSTICAS
CAMBIAR CONTRASEÑA

COPIA DE BASE DE DATOS

02 • Escriba en las áreas en blanco y haga clic en"Ok".
NOTA:  El "New Passord" and "Confirm Password" deben ser los mismos. Después de cambiar la 
contraseña actual, reinicie el sistema e inicie sesión nuevamente 
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02. OPERACIÓN BÁSICA DEL SOFTWARE

CARACTERÍSTICAS

02. OPERACIÓN BÁSICA DEL SOFTWARE

CARACTERÍSTICAS

OPCION

03. CARACTERÍSTICAS EXTENDIDAS

Puede cambiar otras configuraciones del sistema.
01 • Haga clic en Tools > Language en la barra de menú para cambiar el idioma .

Cuando habilita las Funciones Ampliadas, debe reiniciar el sistema.

02 • Haga clic en  "Interface Setting" en la barra de submenú para cambiar la interfaz.
House: Utilizado en gestión comunitaria.
Show Getting Started When Login: para guiar el software operativo

03 • Haga clic en "Auto Login" en la barra de submenú para activar la función.
Ya no necesitará ingresar " User Name " y " Password " para iniciar sesión en el sistema

01 • Haga clic en Tools > Extended Functions ampliadas en la barra de menú.
Ingrese la contraseña.
Contraseña: 5678
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03. CARACTERÍSTICAS EXTENDIDAS
ARCHIVO

03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION

01 • Habilite la opción "Active Log Query" para habilitar la consulta de registro.

HABILITAR LA CONSULTA DE REGISTRO GRABAR EVENTOS DEL BOTÓN DE PRESIÓN

Graba cada vez que se usa el botón.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

Debe conectar el sensor de la puerta. Registra el tiempo de" Door Open" y "Door Closed".
NOTA: Después de activar cualquier función, debe cargar "Upload" en la consola.

PERMITIR PERFIL DE TIEMPO

01 • Active la opción "Activate Time Profile" y "Activate Time Seg Limitted Access".
02 • Haga clic en Configuration > Time Profile en la barra de menú.

03 • Haga clic en " New" para agregar un nuevo perfil de tiempo y sus características.
04 • Escriba en las áreas en blanco y haga clic en "Ok ".

Resultado, al agregar una tarjeta de usuario" Normal ", se le permite trabajar en el perfil creado y puede 
iniciar y cerrar sesión dentro del tiempo establecido.
Después de definir los distintos perfiles de tiempo que desea, seleccione los permisos que corresponden 
a los usuarios en Acceso de  Privilegios.

GRABAR EVENTOS ESTATALES DE LA PUERTA
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

HABILITAR CONTROL PERIFÉRICO

01 • Active la opción "Activate Peripheral Control", "Threate Code Valid After RegisgterCard Swipe" y 
Activate Open Too Long Wam".

02 • Haga clic en Configuration > Peripheral en la barra de menú.

03 • "Threat Code" : debe usarse con el lector de tarjeta de teclado PIN.
04 • Haga clic en "Hardware Configuration".

05 • Determine la configuración deseada.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

HABILITAR ACCESO AL TECLADO
01 • Active la opción "Activate Access Keypad".

02 • Haga clic en Configuration > Pwd MGT en la barra de menú.

03 • Determine la configuración deseada.
04 • Haga clic en "Card + PIN", o "Código PIN" o "Controller's Password" o "Manual Input Password", según 
sus preferencias. 

NOTA: en el submenú " PIN Code", la contraseña predeterminada del usuario es 345978.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

HABILITAR ANTI PASS BACK

ACTIVAR BLOQUEO INTERNO

01 •  Active la opción "Activate Anti Pass Back".

01 • Active la opción "Activate Anti Inter Lock".
NOTA: Esta función solo funciona en la MCA-02, con dos puertas.

02 • Haga clic en Configuration > Anti-passback en la barra de menú.

03 • Determine la configuración deseada.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION
02 • Haga clic en Configuration > Inter Lock en la barra de menú.

03 • Determine la configuración deseada.

03 • Determine la configuración deseada, cada grupo que tenga dos o más usuarios juntos puede abrir 
la puerta pasando sus tarjetas juntas.

ACTIVAR ACCESO A VARIAS TARJETAS
01 • Active la opción "Activate MultiCard Access".
02 • Haga clic en Configuration > Multi-card en la barra de menú.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

ACTIVAR PRIMERA TARJETA DE APERTURA
01 • Active la opción "Activate First Card Open".

04 • Active la opción "Active" y determine la configuración deseada.

02 • Haga clic en Configuration > First Card  en la barra de menú.

03 • Seleccione el usuario y haga clic en "Edit".
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
CONFIGURACION CONFIGURACION

HABILITAR LISTA DE TAREAS DE CONTROLADOR
01 • Active la opción "Activate First Controller TaskList".

02 • Haga clic en  Configuration > Task List en la barra de menú.

03 • Puede agregar tareas, hacer clic en "Add" o editar tareas, hacer clic en "Edit".

04 • Determine la configuración deseada.
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
OPERACIÓN MULTIFUNCIONES

HABILITAR APERTURA REMOTA DE LA PUERTA HABILITAR COMIDA
01 •  Active la opción "Activate Remote Open Door". 01 • Active la opción "Activate Meal".

01 • Haga clic en  "Const Meal" en la barra de menú.

02 • Haga clic en  Operation > Console en la barra de menú.
03 • Primero seleccione el puerto deseado, y luego haga clic en " Remote Open ".
Resultado, la puerta seleccionada se abrirá.

• CONFIGURAR COMIDA

• • LECTORES
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02 • Haga clic en "Configuración de comidas", y luego seleccione el submenú "Readers".
03 • Determine la configuración deseada.

01 • Haga clic en"Meal Setup", y luego seleccione el submenú "Rules".
02 • Determine la configuración deseada.

01 • Haga clic en"Meal Setup", y luego seleccione el submenú "Meal Period".
02 • Determine la configuración deseada.

03 • También puede establecer la cantidad de consumo, hacer clic en "Option" y determinar la 
configuración deseada.

03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

• • REGLAS

• • PERÍODO DE COMIDA
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• INFORME DE COMIDA

• • INFORME DE DETALLES DE COMIDA

• • INFORME DE ESTADO DE LECTORES • • INFORME DEL ESTADO DE USUARIOS

• • INFORME DE ESTADO DE SUBTOTAL DE DEPARTAMENTO

01 • Haga clic en "Create" y se mostrarán todos los detalles de comidas de los usuarios.

01 • Haga clic en "Create" y seleccione "Subtotal of Readers" en el submenú, y todas las comidas y el 
dinero se organizarán por zona.

01 • Haga clic en "Create" y seleccione "Statistics" en el submenú, y el tiempo y el dinero total gastado 
por cada usuario se organizarán estadísticamente.

01 • Haga clic en "Create" y seleccione "Subtotal of Department" en el submenú, y todas las comidas y el 
dinero se organizarán por departamento.

03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES
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03. CARACTERÍSTICAS EXTENDIDAS03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

HABILITAR PATRULLA
01 • Active la opción "Activate Patrol".

02 • Haga clic en "Patrol" en la barra de menú.

• CONFIGURAR PATRULLA

• • PUNTO DE PATRULLA

• • REGLAS DE PATRULLA

01 • Haga clic en "Patrol Setup".

02 • Establezca el puerto en "Patrol Point".

01 • Haga clic en "Patrol Point", seleccione "Patrol Rules" en el submenú y configure las reglas actuales.
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03. CARACTERÍSTICAS EXTENDIDAS 03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

• • HOMBRE PATRULLA

01 •  Haga clic en "Patrol Point", seleccione "Patrolman" en el submenú y configure el usuario que es el 
hombre de la patrulla.

01 • Haga clic en "Route".

02 • Haga clic en "New" para agregar una ruta de patrulla.

03 • Determine la configuración deseada.

• RUTA DE PATRULLA
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03. CARACTERÍSTICAS EXTENDIDAS 03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

01 • Haga clic en "Task" y configure el usuario que realizará la ruta de patrulla. No olvide obtener el registro antes de crear el informe.
01 • Haga clic en "Create".

02 • Haga clic en "Arange" y luego en "Ok".

02 • Haga clic en "Query Option" y configure el filtro que desee.
03 • Haga clic en "Query".

• TAREA DE PATRULLA • INFORME DE PATRULLA
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03. CARACTERÍSTICAS EXTENDIDAS 03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

01 • Haga clic en"Statistics".
El resultado aparecerá en las estadísticas del estado del hombre patrulla.

01 • Haga clic en "Address Setup".

01 • Active la opción "Activate Meeting".

• ESTADÍSTICAS DE PATRULLA • ESTABLECER DIRECCIÓN

HABILITAR REUNIÓN
02 • Haga clic en "Add" para establecer la dirección de la reunión.
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03. CARACTERÍSTICAS EXTENDIDAS 03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES
03 • Ingrese el nombre de la reunión en el área "Meeting Address", configure el puerto y luego haga clic 
en "Ok".

01 • Haga clic en "Add".

01 • Haga clic en "Stat", aparecerán las estadísticas detalladas de la reunión deseada. Puede filtrar por 
"Should", "In fact", "Leave", "Absent", "Late", "Total statistical" y "Calculate participants rate".

02 • Agregue la reunión como reunión semanal, "Weekly Meeting"o cualquier otra configuración que 
desee.
03 •  Identifique a los usuarios como"Delegate", "Nonvoting Delegate", "Invitational", "Audit", "Employee", 
y "Other".
04 •  Si desea modificar la reunión, haga clic en " Edit", si desea eliminar, haga clic en "Delete" en la 

" interfaz principal" de "Meetings".

• AGREGAR REUNIÓN

• ESTADO DE LA REUNIÓN
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03. CARACTERÍSTICAS EXTENDIDAS 03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES MULTIFUNCIONES

01 • Haga clic en "Realtime Sign", aparecerá en tiempo real presente en la reunión.

• ENTRADA EM TIEMPO REAL • HABILITAR LA GESTIÓN DEL OPERADOR

CARACTERÍSTICAS

01 • Active la opción "Activate Operator Management".
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04. SERVICIO03. CARACTERÍSTICAS EXTENDIDAS
MULTIFUNCIONES REGLAS NORMALES DE GIRO
02 • Haga clic en "Tool", luego "Operator Management".

02 • Haga clic en "Attendance", luego en "Normal Shift Rule".

03 • Use "New", "Edit", "Del", "Edit Privilege", "Groups", e "Zones" para el usuario.
04 • Haga clic en "Edit Privilege" para asignar una operación ejecutiva y privilegio de rol a los usuarios.
NOTA: " abc " es el administrador de seguridad máxima predeterminado, no puede usar "Del" o "Edit 
Privilege".

01 •  El sistema tiene activada la función predeterminada  "Attendance" . Si desea cancelar esta función, 
active la opción "Don't Display Attendance".
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04. SERVICIO04. SERVICIO
VACACIONESREGLAS NORMALES DE GIRO

01 • Haga clic en "Attendance", luego "Holiday".

01 • Haga clic en "Attendance", luego "Leave Business Trip".
VACACIONES

VIAJE DE TRABALHO

02 • Determine la configuración deseada. 02 • Determine la configuración deseada.
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02 • Determine la configuración deseada.

04. SERVICIO04. SERVICIO
ENTRADA MANUALVIAJE DE TRABALHO

01 • Haga clic en "Attendance", luego en "Manual Sign". 01 • Haga clic en "Attendance", luego en "Attendance Report".

ENTRADA MANUAL INFORME DE ATENDIMENTO

02 • Determine la configuración deseada.
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05. APÉNDICE04. SERVICIO
CONFIGURACIÓN DEL SERVIDOR SQLINFORME DE ATENDIMENTO

02 • Haga clic en "Create", luego en "Ok".

03 • Haga clic en "Statistics".

01 • Instale SQL Server y luego configure "Access Control SQL Server".
02 • Haga clic en  Operation > Programs > AccessControl > SqlSet.

03 • Haga clic en "Test Conection", y luego en"Ok".
04 • Haga clic en "Create Database",  y luego en "Ok". La base de datos actual se eliminará y creará una 
nueva.
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05. APÉNDICE05. APÉNDICE
IMPORTAR INFORMACIÓN DEL CONSUMIDOR POR EXCELCONFIGURACIÓN DEL SERVIDOR SQL

Verá la base de datos creada en la barra inferior del sistema como "SQL: AccessData".

NOTA: Solo puede importar información válida de "ConsumerNO" , "Name", "CardID " y "Department".
01 • Haga clic en Configuration > Personnel > Export to Excel.
02 • Elija el archivo para exportar la información, luego haga clic en Guardar.

05 • Haga clic en Configuration > Personnel > Import.
06 • Haga clic en "Ok" y luego en "Ok".

03 • Abra el archivo Excel exportado, mencionado en la ventana de información.

04 • Si el documento ya tiene información de usuario, puede eliminarlo si lo desea y crear nuevos 
usuarios. Cree solo información de "ConsumerNO", "Name"," CardID" y "Department" .
NOTA: En el Departamento simplemente use "\" como separador. Por ejemplo: Sales Dep\Oversea 
Marketing.

IMPORTAR INFORMACIÓN DEL CONSUMIDOR POR EXCEL
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Resultado, se creó la base de datos.

05. APÉNDICE
IMPORTAR INFORMACIÓN DEL CONSUMIDOR POR EXCEL


